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1 Introduction
This document describes how escalations can be defined and users are informed prior to
expiration of activities. By default, names of activities whose deadline for beginning or completion
has expired are shown in italics. For missed deadlines an escalation can be configured. In this way
for example a message is sent to one or multiple users to inform them about expiration of the
deadline.

2 Software Requirements
System environment: All information contained in this document implicitly assumes a Microsoft
Windows environment.
Supported platforms: For detailed information on supported operating systems and software see
the software product information on the Fabasoft distribution media.

3 Prerequisites
In the Fabasoft Folio Domain the software product Fabasoft Folio/Wf (ComponentWf@1.1) has to be
installed so that workflow escalations can be defined.
Escalations are triggered automatically. For this the installation and configuration of a Fabasoft
Folio AT Service is required and the software product Fabasoft Folio/AT (ComponentAT@1.1) has to
be installed in the Fabasoft Folio Domain. The installation and configuration of the Fabasoft Folio AT
Service is not part of this document. However, it describes some key points concerning the
execution of automated tasks.

4 Settings for Running Tasks using a Fabasoft Folio AT Service
Escalations are triggered automatically using a Fabasoft Folio AT Service. For this purpose a task list
and an automated task have to be created (see chapter 5 “Creating Automated Tasks”).
For executing automated tasks the user in whose context the Fabasoft Folio AT Service is running
has to be registered in the Fabasoft Folio Domain.
In case of an escalation, users can be notified in different ways, e.g. event in Fabasoft Folio,
message of the Microsoft Windows Messenger Service or e-mail.
Sending e-mails is done via MAPI or SMTP, whereby via SMTP only HTML and plain text can be sent,
RTF is not supported. For sending escalation e-mails, the following settings are required in the
Fabasoft Folio Domain in the MAPI Configuration (COOMAPI@1.1:MAPIConfiguration):
• Preferred Format for “Send as”
e.g. “HTML Mail”
• URL Schema (Protocol) for HTML Mail
e.g. “http”
• Host and Root URL for HTML Mail
Specification of the format: <web server>/<virtual directory>).
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Note: Using tenants, the MAPI Configuration is taken from the tenant of the user, in whose context
the Fabasoft Folio AT Service is running, The type of link, that is inserted into the e-mail, is
determined in the property Preferred Format for “Send as“.
Additionally, the user in whose context the Fabasoft Folio AT service is running needs a MAPI
profile.

5 Creating Automated Tasks
To execute tasks automatically by the Fabasoft Folio AT Service and so be able to send escalation
messages, an Automated Task has to be created and assigned to the Task List (object of the object
class Task List) of the user executing the Fabasoft Folio AT Service.
To assign a Task List to a user, perform the following steps:
1. In the Domain Administration navigate to the object list User Objects and switch to the “List of
Automated Tasks” tab.
2. Depending on whether the Fabasoft Folio AT Service has already been started, there are two
possibilities:
o If the Fabasoft Folio AT Service has already been started, a task list (object of the object class
Task List) has been created automatically. On the “View” menu click “Refresh” to get all
available task lists.
o If the Fabasoft Folio AT Service has not been started yet, manually create a Task List
(COOAT@1.1001:TaskList)).
3. Edit the properties of the task list.
o On the “Object” tab the Name can be edited.
o On the “Security” tab, select as Owner the user in whose context the task list should be
executed (the user executing the Fabasoft Folio AT Service). Thereby the user gets the right
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to change the task list and so to be able to add tasks to the task list.

o On the “List of Automated Tasks” tab, Automated Tasks (COOAT@1.1001:Task) can be entered
in the Tasks area. An object of this object class defines a task to be executed by a Fabasoft
Folio AT Service. A task specifies what action is executed on which object and when it is
executed.
Click “Create” to create an Automated Task.

o Type a name for the task and click “Next”.
o Now edit the properties of the Automated Task.
▪ In the Start on/at field enter a date for the beginning.
▪ In the dropdown list Object create an object of the object class List of Background Activities
(COOWF@1.1:BackgroundActivities). Type a name for the created object and click
“Next”.
▪ In the Action field, find the action “Check expired activities in background”
(COOWF@1.1:CheckExpiredActivities) to search for expired activities in the background.
The search for expired activities uses the search area Query for Worklist
(COOWF@1.1:WorkListQuery). As search criteria the properties
Activity State (COOWF@1.1:actinststate),
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Period of Time for Submission (COOWF@1.1:actinstsubmitdeadline),
Period of Time for Start (COOWF@1.1:actinststartdeadline) and
Period of Time for Completion (COOWF@1.1:actinstenddeadline) are used.
▪ Tasks for checking the escalation of activities are triggered periodically. Enter a value for
Repetition and a Repetition Type (e.g. “Minutes After Ending”).
Note: An escalation is triggered by an automated task. If in the automated task a longer
period is defined for repeating the task than in the Escalation Definition for repeating the
escalation, the escalation is triggered when the automated task is executed.
▪ Additionally can be determined which information should be logged (Configuration for
History) and how many entries are displayed in the History field (Maximum Number of
History Entries).

▪ Switch to the “Security” tab. In the Owner field select the user to which the task should be
assigned (the user executing the Fabasoft Folio AT Service).
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▪ Click “Next” to save the settings for the automated task. Now the task is in the Tasks area
of the Task List object.

4. Click “Next” to save the metadata settings of the List of Automated Tasks.
To assign the list of automated tasks to the user object of the user executing the Fabasoft Folio AT
Services, perform the following steps:
1. In the Domain Administration navigate to the object list User Objects and switch to the “Users”
tab.
2. Open the context menu of the user to which the list of automated tasks should be assigned
and click “Properties”.
3. On the “Advanced” tab, in the List of Automated Tasks field search for the List of Automated Tasks
you have been creating in the previous description.
4. Click “Next” to save the user settings.
Note: After the first start of the Fabasoft Folio AT Service, the task “Check list of background
activities” is added to the List of Automated Tasks automatically. It is created automatically and
checks whether workflow activities are available that should be executed in the background.
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6 Defining an Escalation
An escalation can be used to inform a user when deadlines of activities are nearly or already
expired. Workflow escalations are defined in objects of the object class Escalation Definition
(COOWF@1.1:EscalationDefinition).
To create an Escalation Definition, perform the following steps:
1. Switch to a Administration Tool.
2. Create an Escalation Definition (“Object“ > “New“).
3. On the context menu of the Escalation Definition click “Properties”.
4. Edit the metadata of the Escalation Definition. The following escalation settings are available:
o Escalation, if Date for Submit Is Expired
o Escalation, if Deadline for Start Is Expired
o Escalation, if Deadline for Completion is Expired
Each of these fields contains the following fields:
o Escalation Type
In this dropdown list is determined, whether the escalation is done before or after expiry of
the deadline.
Selecting “Before Expiry of Deadline” the escalation is triggered before the deadline expires,
but earliest one week before expiry. To get the concrete time for escalation, the deadline is
deducted by the specified Period of Time.
Selecting “After Expiry of Deadline” the escalation is triggered after expiry of the deadline. If a
Period of Time is specified, in this case this period is added to the deadline to get the
concrete escalation time.
o Recipients of Escalation Message
In this object list for the escalation message one or more recipients can be determined. The
recipients are defined in a component object of the object class Recipient of Escalation
Message (COOWF@1.1:EscalationRecipient).
All entries in the Recipients in Fabasoft Folio field are dissolved and handled separately. There
is no check for double entries.
If a recipient cannot be dissolved or a message cannot be delivered the escalation is not
canceled. If the number of successful messages is higher than the number of errors the
activity is considered as successfully escalated. The errors are logged in the Fabasoft Folio AT
Service.
o Message Text
In this field type the message text that should be used for escalation.
o Action to Call
In is possible to select an action that is executed on the activity after expiry of the deadline
before sending the escalation message.
o For Workflow Priority
In this dropdown list a priority can be selected. In this case, only activities having this priority
are escalated.
o Period of Time
Depending on the Escalation Type, the deadline is deducted by the specified period
(escalation before expiry) or the period is added to the deadline (escalation after expiry).
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o Repeat Every
This field can be used to determine a time interval for repeated execution of the escalation.
Note: An escalation is triggered by an automated task. If in the automated task a longer
period is defined for repeating the task than in the Escalation Definition for repeating the
escalation, the escalation is triggered when the automated task is executed.
If there is no suitable Recipient of Escalation Message is available, a new one can be created.
Therefore in the Recipients of Escalation Message field perform the following steps:
1. Click “New”.
2. Type a name for the recipients and click “Next”.
3. On the context menu click “Properties”.
4. Edit the metadata of the Recipient of Escalation Message and click “Next”.
On the “Recipient of Escalation Message” the following properties are available:
• Multilingual Name
In this field a name can be defined for the object.
• Types of Escalation
In this dropdown list select the way in which the message is received.
o “Fabasoft Folio Event”
In this case the escalation message is displayed as Fabasoft Folio Event for the users
specified in the Recipient in Fabasoft Folio field.
Note: For this escalation type the user executing the Fabasoft Folio AT Service needs change
permissions on the User Events object of the user receiving the escalation message.
o “NT Messenger Service Message”
In this case the escalation message is sent via Microsoft Windows Messenger Service to the
recipient specified in the NT message to field. If this field is left empty, the login name of the
user specified in the Recipient in Fabasoft Folio field is used.
o “E-Mail”
In this case the escalation message is sent via e-mail whereas the escalated activity is
inserted as a link. The e-mail is sent to the recipient defined in the E-Mail to field. If this field
is left empty, the e-mail address of the user specified in the Recipient in Fabasoft Folio field is
used. The e-mail is sent by the action COOMAPI@1.1:SendObjects (for further information
see chapter 4 “Settings for Running Tasks using a Fabasoft Folio AT Service“).
• Recipient in Fabasoft Folio
In this field specify a user of the Fabasoft Folio Domain as recipient for the escalation. The
specified user is informed:
o using the escalation type “Fabasoft Folio Event”.
o using the escalation type “NT Messenger Service Message”, if the NT Message to field is left
empty.
o using the escalation type “E-Mail”, if the E-Mail to field is left empty.
o Note: For further information to this field see chapter 6.1 “Evaluation of the Recipient in
Fabasoft Folio”.
• NT Message to
Using the escalation type “NT Messenger Service Message” a Microsoft Windows Messenger
Service contact name can be specified.
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• E-Mail to
Using the escalation type “E-Mail”, an e-mail address can be specified in this field.
The objects Escalation Definition and Recipient of an Escalation Message are component objects, so
on the “Component Object” tab a Reference and a Software Component have to be entered.

6.1 Evaluation of the Recipient in Fabasoft Folio
In the escalation definition in the Recipient in Fabasoft Folio field the recipients of the escalation
message are defined. The definition can be done using abstract participants or concrete users. The
following possibilities are available:
• Abstract Participant
In this dropdown list an abstract participant can be selected:
o Process Initiator
Process initiator is the person who initiated the process of the activity.
o Responsible for Process
For each process a responsible is defined. By default the process initiator is responsible for
the process.
o Process Owner
The process owner is the owner of the process instance.
o Process Group
The process group is the group to which the process instance belongs. If no further
restrictions (e.g. a position) are defined, all users of this group are informed about the
escalation.
o Object Owner
The object owner is the user who is owner of the object on which the process has been
initiated.
o Object Group
The object group is the group to which the object belongs on which the process has been
initiated. . If no further restrictions (e.g. a position) are defined, all users of this group are
informed about the escalation.
o Current User
The current user is the user the activity is assigned to.
o According to the organizational structure further options are available.
• User
In this field a concrete user can be selected by performing a search or using the hierarchical
structure.
• Group
In this field a concrete group can be selected by performing a search or using the hierarchical
structure. If no further restrictions (e.g. a position) are defined, all users of this group are
informed about the escalation.
• Position
In this field a position can be selected. If no further restrictions (e.g. a group) are defined, all
users having this position are informed about the escalation.
• Organizational Unit
In this field an organizational unit can be selected.
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If no concrete user is defined, the selected values are used to get a list of users receiving the event.
So the event is sent e.g. to all users of a group or all users of a certain position. If several values are
selected, all of them have to be true for a user to be a recipient.
If the evaluation determines a user several times, he or she receives the event several times.
If a recipient cannot be dissolved or a message cannot be delivered the escalation is not canceled.
If the number of successful messages is higher than the number of errors the activity is considered
as successfully escalated. The errors are logged in the Fabasoft Folio AT Service.

7 Triggering an Escalation
To trigger an escalation an Escalation Definition has to be defined for example when prescribing or
editing an activity. An Escalation Definition can also be predefined in an Activity Definition or for all
activities of a process in a Process Definition.
Deadlines for the escalation can be defined in Activity Definitions, in Activities or when prescribing an
activity.

7.1 Activity Definition
The following properties are available in an Activity Definition on the “When” tab:

• Period of Time for Submission
In this field a period of time can be defined within that the activity should be submitted.
• Period of Time for Start
In this field a period of time can be defined within that the activity should be started. The
calculation starts when the user receives the activity in the worklist.
• Period of Time for Completion
In this field a period of time can be defined within that the activity should be completed. The
calculation starts when the user receives the activity in the worklist.
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• Working Days Until Submission
In this field a number of working days can be defined within that the activity should be
submitted.
Note: For evaluating working days when calculating deadlines in the current domain a Holyday
Table has to be defined.
• Working Days Until Start
In this field a number of working days can be defined within that the activity should be started.
The calculation starts when the user receives the activity in the worklist.
• Working Days Until Completion
In this field a number of working days can be defined within that the activity should be
completed. The calculation starts when the user receives the activity in the worklist.
• Expressions to Compute Deadlines
In addition to defining periods and working days, deadlines also can be calculated using
Fabasoft DUCX Expressions. Therefore the Expressions to Compute Deadlines field is available.
For the evaluation of the expression the current activity is in the global scope.
• Escalation
In this field an Escalation Definition can be selected or created.
The values of the Activity Definition are used when creating an activity.

7.2 Performing Prescriptions
Deadlines for the escalation and an Escalation Definition can be defined during the prescription an
activity.
To configure an escalation in the scope of prescribing an activity, perform the following steps:
1. Select a business object.
2. On the “Tools” menu click “Start new Activities” and click the button “Advanced View”.
3. Click “Open Detail” to get the detail view of an aggregate line.
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4. Edit the fields of the prescription as needed. In the Escalation field select an Escalation
Definition.

5. Click “Next” to close all dialog windows and save the settings. The prescription is performed
automatically.
If in the scope of the prescription the fields Period of Time for Submission, Period of Time for Start,
Period of Time for Completion and Escalation are left empty, the values are taken from the Activity
Definition.
Note:
• Only values that are not defined in a prescription are taken from the Activity Definition.
• If in the User Environment of a user the option Use Working Days for Deadlines is set to “Yes”
(“Workflow” tab) deadlines can be defined using working days.

7.3 Activity
The Escalation Definition and periods for submission, start and completion can be read, defined and
changed directly in the activity.
For this purpose the following fields are available on the “When” tab of an activity:

• Date for Submission
In this field a date for submission can be defined, if the activity has yet not been submitted.
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• Deadline for Start
In this field a date for starting the activity can be defined.
• Deadline for Completion
In this field a date for completing the activity can be defined.
• Escalated on/at
In this field the date of the last escalation gets noted.
• Escalation
In this drop-down list an escalation definition can be selected.
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